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Intended Use 
 

 
ClinicalExpress is intended for forwarding a DICOM image from a medical 

image digitizer to either DICOM print class provider or a storage class provider.  

The target population is user’s wishing to use a medical film digitizer to scan 

analog or transmissive films to a DICOM workstation using a traditional 

teleradiology approach and users wishing to make duplications of film prints 

using digital technology in DICOM and postscript protocols. 
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About this manual 

 

 

 

This manual provides step-by-step instructions for installing and using 

ClinicalExpress®.  The manual is organized around these topics: 

 

 About ClinicalExpress describes ClinicalExpress as part of a typical DICOM 

radiography or mammography system. 

 

 Installing ClinicalExpress reviews system requirements and provides 

instructions for installing the software. 

 

Note:  Consult the DICOM Conformance Statement, a separate 
document, for connectivity information. 

 

 Configuring ClinicalExpress shows how to configure the ClinicalExpress 

film capture and transmission systems, and discusses other topics of interest to 

those managing ClinicalExpress systems. 

 

Note:  Operating instructions are provided in a separate 
manual, the “ClinicalExpress operator’s guide.” 

 

 

 

Conventions used in this manual 
 

 Special keys you press on the keyboard are shown using SMALL CAPITALS.  For 

example, when you read the word ENTER in the text, press the corresponding 

key on your keyboard. 

 

 Menu names and menu commands appear in block letters.  For example, the 

File menu contains the Install License command.  In this manual, commands 

are expressed in a shorthand notation.  For instance, File > Exit means select 

the Exit command in the File menu. 

 

 Windows, buttons, dialog boxes and other on-screen features are named in 

bold type.  For example, the ClinicalExpress Login window (below) contains 

User Name and Password fields, and buttons labeled OK and Cancel. 
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About ClinicalExpress
®

 

 

 

 

 

ClinicalExpress 6.1 is a Windows-based program that digitizes films and 

transmits film images.  The program incorporates General Radiography and 

Mammography modes, and can be purchased for General Radiography only, for 

Mammography only, or for both modes. 

 

Digitizing.  Using a VIDAR film digitizer for input, ClinicalExpress displays 

film images and associates them with a patient and study.  The program provides 

a set of controls for examining an image for quality control and adjusting its 

characteristics. 

 

Indications for use.  General radiology images digitized using ClinicalExpress 

meet or exceed the ACR and DICOM standards for use of secondary capture 

images for consultation, review and final interpretation. 

 
Mammography images digitized using ClinicalExpress as DICOM MG are to be 

used as reference or comparison only, and not for primary diagnosis. 

 

 

 

Options 
 

These options can be purchased separately: 

 

Modality Work List.  This option enables imaging modalities to download work 

list information about scheduled procedures and related data, present this 

information to the modality operator, and assure that DICOM images contain 

consistent descriptive data.  Instructions for using the Modality Work List in 

ClinicalExpress are provided in this manual.  Integration details are provided in 

the DICOM Conformance Statement. 

 

PDI.  This option includes the DICOM Media Import/Export (for reading and 

writing DICOM CDs), Flat Bed Paper Scanning and Patient Query (for searching 

patient information on storage devices). 
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System overview 
 

A typical ClinicalExpress film capture and transmission workstation consists of: 

 

 VIDAR film digitizer to create digital images from films. 

 

 Windows® XP 32-bit or Windows 7 32- or 64-bit computer running the 

ClinicalExpress program. 

 

 

Notes 

 The ClinicalExpress workstation is NOT a diagnostic 
workstation.  For diagnostic tasks, use an appropriate 
workstation (see diagnostic workstation’s installation and 
operation guide for instructions). 

 Mammography images digitized using ClinicalExpress shall 
be used only for reference and review, and must not be used 
for primary diagnosis. 

 

 

 

General Radiography Mode 
 

For image transmission, the workstation outputs to a data connection, which 

delivers image data to a remote workstation or system.  For copying, the 

workstation connects to a film printer or non-film output device.  Additional 

input can be provided by an optional document scanner. 
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Mammography Mode 
 

For image transmission, the workstation outputs to a data connection, which 

delivers image data to a remote workstation or system. 
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What you can do with ClinicalExpress 
 

ClinicalExpress 6.1 is your primary point of control for film capture, 

transmission and copying.  With the program, you can: 

 Digitize 

 Designate a patient and study, or create a new patient record and/or study. 

 Using the Modality Work List option (available separately) to pull in 

patient information from an external source (instead of typing patient data). 

 Set basic digitizing parameters: bit depth and resolution. 

 Digitize one or more films. 

 Perform quality check on the image created from the film before sending or 

copying it. 

 Manipulate the image: set window and level, rotate, flip, invert tonal 

values, split images, magnify a region of interest, zoom and redact 

sensitive information. 

 Transmit 

 Select a remote workstation or system (the “target”). 

 Send digitized images to the selected target. 

 Digitize and send in one operation. 

 Copy (General Radiography Mode only) 

 Select a printer (if multiple printers are connected to the system). 

 Set the number of copies to be made from each film original. 

 Initiate printing. 

 Combine multiple images on one film. 

 Digitize and print in one operation. 

 Import from, and export to, DICOM standard CDs. 

 

ClinicalExpress is licensed on a feature/function basis.  All licenses include the 

digitizing function as well as DICOM Send (sending to DICOM Service Class 

Providers, workstations/PACS) and Copy (printing to DICOM printers and /or 

Postscript devices).  Additionally, you can purchase licenses for: 

 Modality Work List. 

 PDI.  CD burning from DICOM viewer to Media Export, Media 

Import/Export, Patient Query and Paper Document Scanner. 

 

 

New features in ClinicalExpress 6.1 
 

 New date format options. 

 DICOM mammography Derived/Primary tag support for compatibility with 

GE sites. 

 Mammography tag date acquisition support for compatibility with Siemens 

sites. 
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Installing ClinicalExpress
®

 

 

 

 

 

System requirements 
 

To digitize and transmit images using ClinicalExpress®, you will need to provide 

a computer system, a VIDAR film digitizer and a network connection. 

 

 

Computer 
 

The minimum computer system for Windows XP 32-bit SP3 is: 

 3.0GHz Pentium 4 PC 

 2 GB of memory; more memory is required for large sets of high resolution 

images such as mammography 

 50GB of free space on hard drive 

 

The minimum computer system for Windows 7 Professional 32-bit and 64-bit is: 

 Dual Core 2 1.8GHz PC 

 4 GB of memory, more memory is required for large sets of high resolution 

images such as mammography 

 50GB of free space on hard drive 

 

Video for all computers: 

 Video card with 16MB memory, set to 1280x1024 resolution and 64,000 

colors or higher color depth 

 20" display with 1280x1024 resolution 

 

 

Film digitizer 
 

ClinicalExpress works with most VIDAR Medical Film Digitizers.  Contact 

Medtech at medtech@3Dsystems.com to determine if your digitizer is 

compatible. 

 

ClinicalExpress does not work with film digitizers made by other manufacturers. 

 

 

Network connection 
 

Suitable network connections include, but are not limited to, LAN, WAN, 

wireless and a variety of telephone-based services.  TCP/IP is required for proper 

operation.  Network connection details are beyond the scope of this manual. 

 

 

mailto:medtech@3Dsystems.com
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Optional document scanner 
 

You can add a USB document scanner to your system.  ClinicalExpress works 

with most TWAIN drivers.  The ability to use a document scanner is a purchased 

option.  Contact VIDAR Technical Support (see below) for a list of tested 

scanners. 

 

 

Installation scenarios 
 

Review the scenarios below to determine your current status, and how you 

should perform the ClinicalExpress 6.1 installation. 

 

 

 If you are installing ClinicalExpress for the first time: 

1. Run the ClinicalExpress6.1..exe file on the ClinicalExpress CD. 

2. The software will run in a 30-day evaluation mode.  To use the software 

beyond 30 days, you will need a license key (see “Obtain a ClinicalExpress 

license key,” later in this chapter). 

 

 

 If an earlier version of ClinicalExpress is currently installed: 

 For installed versions 4.x and earlier, contact VIDAR Technical Support 

(see below) for upgrading instructions. 

 For installed version 5.0 and later, you can install ClinicalExpress 6.1 but 

you must uninstall the previous version before installing the new version. 

You will need to request a new license after this installation is complete.  

(see “Obtain a ClinicalExpress license key,” later in this chapter). 

 

 

 

 

Contact VIDAR Technical Support if you have any questions 
about installing ClinicalExpress software: 

Phone: +1.800.471.SCAN (+1.800.471.7226) 

 +1.703.471.7070 outside the U.S. 

E-mail: medtech@3Dsystems.com 
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Installation overview 

 

Note:  You must be logged on as the Administrator to install 
and License ClinicalExpress and perform administrative 
functions.  Users can have, but do not require, administrative 
rights to the PC 

For instructions see: 
 The “To add a member to a group” topic in the Windows XP 

Help and Support Center. 
 The “Create a new user account” and “Modify a user 

account” topics in the help file for the Windows Computer 
Management window. 

 

Installation involves five general steps: 

A. Install and configure the film digitizer. 

B. Set the display. 

C. Install ClinicalExpress software. 

D. Launch ClinicalExpress. 

E. Obtain a ClinicalExpress license key. 

 

Details are provided in the following sections. 

 

Tip:  If you are building a new workstation, don’t install all 
components at the same time.  Instead, first install the film 
digitizer (according to instructions provided with the digitizer).   
Next, set the display (step B).  Finally, install the ClinicalExpress 
software (step C), and assure the system is operating. 

 

 

 

A. Install and configure the film digitizer 
 

Install and configure the film digitizer and its software, according to instructions 

provided with the digitizer (details are beyond the scope of this manual). 

 

 

Note:  You can download VIDAR film digitizer installation and 
operation guides from the Customer Support section at 
www.vidar.com.  You can also request manuals by calling 
+1.800.471.7226 (+1.703.471.7070 outside the U.S.). 

 

Windows 7 users will have to change their User Account Controls to allow for Auto 
Launch of ClinicalExpress upon boot up of your PC.  This can be found under 
Start<Control Panel>User Accounts.  Select Change User Account Control Setting and 
slide the bar to the Never position.  Select OK. 
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B. Set the display 
 

1. Right-click the desktop, then click Properties in the pop-up menu. 

 

  
 

Note:  On your system, a display adapter-specific command 
may be substituted for the Properties command.  If so, click 
that command.  The display properties dialog may be different, 
but the objective is the same:  set the display resolution to 1280 
x 1024 or higher, and set the color depth to 16-bit or higher. 

 

2. In the Display Properties window, click the Settings tab. 
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3. Set Screen Area (or Screen Resolution) to 1280 by 1024 or higher, and set 

Colors (or Color Quality) to High Color (16 bit) or higher. 

 

  
 

4. Click OK. 
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C. Install ClinicalExpress software 
 

Note:  If you are upgrading from ClinicalExpress 4.x or earlier, 
contact VIDAR Technical Support at medtech@3Dsystems.com 
for instructions. 

 

Note:  You can install ClinicalExpress without the film digitizer 
in the system.  However, ClinicalExpress will not operate unless 
the film digitizer is connected to the computer, is turned on and 
is communicating with the computer. 

 

1. Insert the ClinicalExpress CD into your computer’s CD drive. 

 

2. In Windows Explorer, navigate to the CD drive, then double-click 

ClinicalExpress6.1..exe. 

 

3. Follow the instructions in the installer windows. 

 

 During the installation, you will be asked to select the default GUI—General 

Radiography or Mammography—that is displayed when ClinicalExpress is 

launched.  Select the most appropriate GUI for your organization (this choice 

can be changed in ClinicalExpress’s Administration > Local page). 

 

4. After the installation is complete, remove the CD-ROM from the CD-ROM 

drive.  (You will need the CD key from the CD label in step E.) 

 

 

 

 

Adding a flatbed paper scanner 
 

You may install a flatbed paper scanner for use with ClinicalExpress.  Follow the 

scanner manufacturer’s installation instructions.  VIDAR has tested typical USB 

2.0 scanners with TWAIN drivers and found them to be compatible with 

ClinicalExpress. 

 

Note:  Only the flatbed scanner’s TWAIN driver should be 
installed on the ClinicalExpress workstation.  Presence of any 
other TWAIN drivers may interfere with the operation of 
ClinicalExpress.  Contact VIDAR Technical Support at 
medtech@3Dsystems.com for a list of tested scanners. 

 

mailto:medtech@3Dsystems.com
mailto:medtech@3Dsystems.com
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D. Launch ClinicalExpress 
 

Note:  If this is a New installation ClinicalExpress will operate 
for 30 days without a license key.  To continue using 
ClinicalExpress beyond this period, contact VIDAR Systems 
Corporation to obtain a license key (instructions are provided in 
the next section). If this is an upgrade you may be required to 
obtain a new license after installation to use the  

 

1. Double-click the ClinicalExpress icon on the desktop.  

  or 

 Start > All Programs > ClinicalExpress. 

 

2. The User Login window will appear: 

 

  
 

3. Use the default Administrator name/password: 

a. Leave the User Name as Admin. 

b. Leave the Password blank. 

c. Click OK. 

 

4. If the digitizer is on and properly connected, the message below will appear.  

Click OK. 

 

  
 

5. ClinicalExpress will launch. 

 

Note:  You cannot digitize films until at least one valid target is 
defined.  See “Configuring ClinicalExpress,” the next chapter in 
this manual. 
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E. Obtain a ClinicalExpress license key 
 

Note:  You cannot obtain a license key by faxing the Clinical-
Express license agreement.  You must follow the instructions in 
this section to obtain a license key by e-mail. 

 

Obtain a license key as follows: 

 

1. Generate a reference code and send it to VIDAR: 

 

Note:  You can only generate a reference code if the Clinical-
Express computer is connected to a VIDAR film digitizer. 

 

a. In the ClinicalExpress main window, File > Generate Reference Code. 

 

b. In the Generate Reference Code dialog: 

 Enter or change User Name, Company and Country. 

 Enter the CD Key written on the label of the ClinicalExpress 

installation CD. 
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c. Click the Generate Reference Code button. 

 

  
 

Note:  The reference code is valid for 15 days. 

 

d. Click the Save button to save the reference code as a file on the local hard 

drive. Save the file to a location you can easily remember. 

 

e. Click the Close button. 

 

f. Start a new e-mail message. 

 

g. In the message’s To field, enter medtech@vidar.com . 

 

h. Then: 

 

 Locate the file (it will have the .ref extension) you saved in step d above 

and attach it to the message. 

 

i. Send the message. 

 

Note:  While you are waiting for your license key, you can use 
ClinicalExpress in evaluation mode without a key for up to 30 
days.  All features are enabled during the 30-day evaluation 
period.  Upgrades may or may not have the 30-day evaluation 
period. 

 



 Installing ClinicalExpress  

P/N 18303-001 Rev. G 
Page 20 of 68 

 

2. After you receive your license key by e-mail from VIDAR: 

 

a. Save the attachment (with extension .key) on your desk top. 

 

b. Log in to ClinicalExpress as an Administrator. 

 

c. In the ClinicalExpress main window, File > Install License. 

 

  
 

d. In the Install License dialog: 

 

 Click the Load From File button, then locate and open the license key 

file (with extension .key). 

 

  
 

e. Click the Register button. 
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f. If the license key is accepted, the window below will appear.  Click OK. 

 

  
 

g. File > Exit. 

 

h. Launch ClinicalExpress again by double-clicking the ClinicalExpress icon 

on the desktop. 

 

i. To verify your license:  Help > About.  Your license will be at the top of 

the page.  If you are licensed for both General Radiography and 

Mammography, you should verify in both applications. 

 

3. Go to “Configuring ClinicalExpress,” next in this manual, to configure the 

program. 

  or 

 If you need to configure ClinicalExpress for printing, please review the 

instructions for setting up printers validated for use with ClinicalExpress, in 

the Printer Specific directory on the ClinicalExpress installation CD. 
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Configuring ClinicalExpress
®

 

 

 

 

 

Introduction 
 

This chapter describes administrative operations that can be carried out within 

ClinicalExpress: 

 Logging in to the Administration window. 

 Setting local workstation parameters. 

 Setting display parameters. 

 Setting digitizer resolutions. 

 Setting image processing options. 

 Defining mammography views. 

 Designating mandatory data entry fields. 

 Managing users accounts. 

 Selecting data fields for anonymizing. 

 Backing up and restoring the license. 

 Defining targets. 

 Reviewing the film digitizer’s configuration. 

 Checking Modality Work List availability. 

 Reviewing and managing the log file. 

 Calibrating the film digitizer. 

 

Additionally, this chapter provides basic instructions for calibrating a workstation 

monitor. 

 

If you are setting up ClinicalExpress for the first time, you should proceed 

through all sections in this chapter and perform all operations that apply to your 

licensed ClinicalExpress functions and system configuration. 

 

Note:  You must be logged in as an administrator for the local 
computer before you can access and make changes in the 
ClinicalExpress Administration window. 

 

Note:  You cannot digitize films until at least one valid target is 
defined.  See “Defining targets,” later in this chapter. 
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Logging in to the Administration window 
 

The ClinicalExpress Administration window is password protected. 

 

1. Options > Administration. 

 

 If you are already logged into ClinicalExpress as the administrator, you will 

see the Administration window and you can skip step 2.  Otherwise, you will 

see the login window: 
 

  
 

2. Enter the administrator Password, then click OK. 

 

 

 

Tip:  The default name is Admin 
(case sensitive) and the default 
password is no password (i.e., 
leave the password field empty). 
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Setting local workstation parameters 
 

Set local workstation parameters in the Local branch of the Administration tree. 
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DICOM Parameters 
 

 
 

 

The Application Entity (AE) Title is the name other software applications use to 

identify this application. 

 

1. Enter the Application Entity Title for this DICOM device (by default, 

“ClinicalExpress” is entered in this field).  The AE Title is case sensitive. 

 

2. Enter the Port Number for this DICOM device (by default, “207” is entered 

in this field). 

 

3. Click the Apply button. 

 

 

Log 
 

 
 

 

1. Change log settings as required: 

 

 Log Level:  Specifies the types of information viewable in the Error Log 

window: 

 INFORMATION displays DICOM information and ClinicalExpress 

information. 

 WARNING displays errors and warnings only. 

 ERROR displays errors only. 

 

 ClinicalExpress automatically captures all errors and information.  (To 

view the entire error log, open the file clx.log in a text editor.) 

 

Note:  The Error Log window is not a full DICOM diagnostic 
tool, as it does not capture full DICOM transmissions.  It is 
primarily for software troubleshooting. 

 

 Keep Log Entries:  Entries in the log file will be deleted after this number 

of days.  (See “Reviewing and managing the log file,” later in this chapter.) 

 

2. Click the Apply button. 
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Localization 
 

 
 

1. Select the Language that will be used in the application’s user interface. 

 

2. Select the Date Format to be used in the application. 

 

3. Click the Apply button. 

 

4 Exit ClinicalExpress and re-launch it to complete the change. 

 

 

 

System 
 

 
 

 

1. Change settings as required (default settings are shown above): 

 

 Minimum Disk Space:  When the free disk space falls below this value, 

ClinicalExpress will automatically delete files, starting with the oldest 

studies that have been successfully sent.  If the program cannot free enough 

disk space to reach the Minimum Disk Space value, it will prevent the 

user from digitizing additional films until adequate space is available. 

 

 Maximum Film Length:  Normally set for 17 inch film length, this value 

can be changed to accommodate longer films. 

 

Note:  Only increase Max Film Length to a value greater than 
17 inches if a DIAGNOSTICPRO

®
 Plus or DIAGNOSTICPRO

®
 

Advantage film digitizer is attached.  Refer to the corresponding 
film digitizer operation guide for information about digitizing 
films longer than 17 inches. 
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Note:  Since the system uses an auto sizing routine to 
determine film length, it may not be possible to digitize 
perforated films. 

 

 Transmission Retries:  Sets the number of times ClinicalExpress will 

attempt to send a study to a target.  ClinicalExpress handles unsuccessful 

study transmissions as follows: 

 If other studies are in the transmission queue, an unsuccessfully sent 

study is placed at the end of the queue and an attempt will be made to 

send the study later—subject to the number of transmission retries and 

retry time (see below). 

 If no other studies are in the transmission queue, ClinicalExpress 

immediately attempts to resend the study—subject to the number of 

transmission retries and retry time (see below). 

 If the study cannot be sent after the set number of transmission retries, 

the study is listed in the Acquired Studies window (View > Acquired 

Studies), where you can manually initiate a transmission. 

 A study that cannot be sent will have a status of “failed” until it is 

successfully sent. 
 

 Retry Time:  Sets the amount of time (in minutes) ClinicalExpress will 

wait before attempting to send a study to a target if the previous attempt 

failed. 
 

 Lists’ Start Field:  Controls whether Patient Name or ID is first column 

in Acquired Studies list and Work List Procedures list. 
 

 Images Path:  If desired, change the default local image storage directory.  

Do this, for example, if you want to store images on a larger-capacity drive 

or partition.  To change the path, click the ... button, then select a new path. 
 

 Lock Keys:  When activated, ClinicalExpress disables keys (e.g., ALT-TAB) 

that would allow a user to switch between ClinicalExpress and other open 

programs. 
 

 Enable Additional Patient’s History:  When activated, ClinicalExpress 

displays the Additional Patient History field at the bottom of the Study 

Information window. 
 

  
Patient/Study/Series Information window without  
Additional Patient History 

Patient/Study/Series Information window with  
Additional Patient History 
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 Auto Generate Accession Number:  When activated, ClinicalExpress 

automatically inserts the next sequential accession number in the Study 

Information window when the user initiates a new study.  The inserted 

accession number can be edited. 

 

 Send Empty Accession Number:  When activated, ClinicalExpress does 

not send accession numbers to targets. 

 

 Send Film Size ID:  When activated, ClinicalExpress sends film 

dimensions to targets. 

 

 Send each image as a Series:  When activated, a each image is sent as a 

series.  When deactivated, a series can include multiple images. 

 

 Set Image Type as DERIVED\PRIMARY:  When activated, each image 

will be tagged for use in GE mammography systems. 
 

2. Click the Apply button. 

 

 

 

Auto Logout 
 

 
 

When activated, ClinicalExpress automatically closes if it detects no user activity 

(keyboard or mouse) after the time indicated. 

 

After changing, click the Apply button. 

 

 

 

Delete After Send 
 

 
 

When activated, ClinicalExpress deletes patients and/or images about 10 minutes 

after they have been successfully transmitted to the target.  Considerations: 

 When activated, these options will help prevent the workstation’s disk from 

filling to capacity with image files.  However, studies sent immediately after 

acquisition, then deleted, will not be listed in the Acquired Studies window, 

and thus cannot be sent to the same or other targets at a later time. 

 When deactivated, these options enable studies to be listed in the Acquired 

Studies window, and they can be sent to other targets at a later time.  

However, studies will accumulate on the workstation’s disk, and may 

eventually fill the disk to capacity. 
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 The ClinicalExpress database is limited to 10GB.  If it reaches this limit, you 

must delete images and patients to continue digitizing films. 

 

After changing, click the Apply button. 

 

 

 

Delete After Storage Commitment 
 

 
 

When activated, ClinicalExpress deletes patients and/or images only after 

receiving a Storage Commitment message from a target.  The message confirms 

that the target has not only received, but also stored, the transmission.  (See 

“Delete After Send,” above, for considerations.) 

 

After changing, click the Apply button. 

 

 

 

Default Startup GUI 
 

 
 

This option specifies the mode display when ClinicalExpress is launched.  If 

licenses for both General Radiography and Mammography have been purchased, 

users can switch between modes. 

 

After changing, click the Apply button. 

 

 

 

Auto Fill Study 
 

 
 

When activated, the current date and/or time is automatically entered in a new 

study. 

 

After changing, click the Apply button. 
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Setting display parameters 
 

Set display parameters in the Local | Display Settings branch of the 

Administration tree. 

 

 

Preset display settings 

 

Display settings automatically apply window and level adjustments to an image 

based on the body part and modality selected by the user.  Settings are based on 

film type, digitizer type and bit depth.  Four preset display settings are shown in 

the screen above.  This section of the Administration window enables you to 

define, change and delete display settings. 
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 To create a new display setting: 

 

a. Click the New button. 

 

b. Click in the Modality field, then type the modality. 

 or 

Select an existing modality from the list. 

 

c. Click in the View field, then type the view. 

  or 

 Select an existing view from the list. 

 

d. Enter window data and level data for one bit depth.  ClinicalExpress 

automatically calculates and fills in corresponding values for the two other 

bit depths. 

 

  

Window Level 

 

 

Window Level 

 

e. Click the Save button. 

 

Note:  ClinicalExpress has pre-calculated window and level 
settings for Body Part = DEFAULT and Modality = DEFAULT.  
These settings are initially applied to images.  The user can 
override the settings with the mouse-driven window level tool, or 
by entering values in the Window and Level boxes in the main 
window, or by using preset window/level values.  The 
administrator can change the default settings (listed at left) as 
described below. 
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 To change the window and level values for an existing display setting: 

 

a. Click the row you want to change. 

 

b. Click the Edit button. 

 

c. Edit window data (left field) and/or level data (right field) for one bit 

depth.  ClinicalExpress automatically calculates and fills in corresponding 

values for the two other bit depths. 

 

d. Click the Save button. 

 

 

 To delete an existing display setting: 

 

a. Click the row you want to delete. 

 

b. Click the Delete button. 

 

 

 To automatically apply window and level adjustments based on film size and 

image resolution:  Activate the Enable Auto Window/Level 
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Setting digitizer resolutions 
 

Set digitizer resolutions in the Local | Digitizer Settings branch of the 

Administration tree. 

 

 
 

 

Digitizer settings automatically set the image resolution based on film width. 

 

 To change a resolution: 

 

a. Click the row containing the film size you want to change. 

 

b. Double-click in that row’s Resolution column. 

 

c. Select the desired resolution. 

 

d. Click the Save button. 
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Setting image processing options 
 

Set image processing options in the Local | Image Processing branch of the 

Administration tree. 

 

 
 

 

Note:  Default settings in the Image Processing window are 
Off (that is, not activated). 
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Note:  ClinicalExpress automatically and permanently applies 
the checked image processing operations to each image 
immediately after it is acquired from the digitizer (and thus, 
before it is displayed or sent).  Users cannot remove the results 
of image processing.  If images do not need image processing, 
the administrator must uncheck the options in the Image 
Processing page, then the user must redigitize the films to 
produce new images. 

 

1. Set image processing options as required: 

 

 Unsharp Mask:  When activated, ClinicalExpress applies the unsharp 

mask algorithm to sharpen image detail.  Select Low, Medium or High to 

control the amount of sharpening. 

 

 DRC (Dynamic Range Compression):  When activated, ClinicalExpress 

applies a nonlinear filter to compress an image’s dynamic range.  Select 

Low, Medium or High to control the amount of compression. 

 

 Post-Digitization Processing: 

 Straighten Image After Digitization:  When activated, images 

exceeding the Threshold Value are automatically straightened after 

capture.  When deactivated, the user can straighten images in the 

ClinicalExpress window. 

 Threshold Value:  Image must be rotated more than this value to 

qualify for automatic straightening. 

 Reset:  Click to restore default threshold values. 

 

Note:  Automatic image straightening assumes film edges are 
straight and at right angles.  Uncheck this option if films have 
been cut. 

 

 Monitor LUT:  When activated, ClinicalExpress applies Look Up Table 

values to the image before it is displayed. 

 From File:  Choose this option if the Look Up Table is available as a 

file.  Enter the path and file name, or click the browse button to 

designate the file. 

 Generate Using Density:  Choose this option to have ClinicalExpress 

generate a Look Up Table based on the specified density value. 

 

 Apply SDF:  When activated, ClinicalExpress applies Standard Display 

Function values to the image before it is displayed, using the specified 

Illumination, Ambient Light, DMin (digitizer’s minimum density) and 

DMax (digitizer’s maximum density) values. 

 

2. Click the Apply button. 

 

 

Default DICOM SDF values 

Illumination 2000 cd/m
2
 

Ambient Light 10 cd/m
2
 

DMin 0 

DMax 255 
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Defining mammography views 
 

Views provide ClinicalExpress users with hanging protocols for assembling 

separate mammography images into composites.  ClinicalExpress comes with a 

default 2x2 protocol.  You can define other views as needed. 

 

Note:  The option to perform document scanning for 
mammography was added to ClinicalExpress 6.1.  If you don’t 
have the PDI option, you must add it to be able to scan 
documents using a flat bed scanner.  You must also define a 
layout in which the Film View is set to PAPER. 

 

Define views in the Local | Mammography branch of the Administration tree. 
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1. Click the New button. 

 

2. In the Views list, click in the Name column, type a name for the layout, then 

press ENTER. 

 

 
 

3. Open the Layout list, then click the desired row x column layout. 

 

4. In the View Order list, set the Film View for each cell.  The Layout Preview 

shows how film views are assigned to cells. 

 

  
 

 

Note:  To scan documents, set Film View to PAPER. 

 

Note:  Patient Orientation is automatically set when you select 
a Film View, and should not be changed. 

 

Note:  Users can override the default Patient Orientation set 
here. 

 

 

 To delete a view: 

a. In the Views list, click the view, then click the Delete button. 

b. Confirm the deletion. 
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 To edit a view: 

a. In the Views list, click the view, then click the Edit button. 

b. In the Views list, click the Name, then type a new name. 

c. In the View Order list, change Film View and Patient Orientation as 

needed. 

d. Click the Save button. 

 

Note:  A view can be deleted or edited only if it is not 
referenced by a study. 

 

 

Understanding views and patient orientations 
 

The following example shows the relationships between views, images and 

patient orientations. 

 

Suppose you define two views as follows: 

 
View A 

Row Column Film View Patient Orientation 

1 1 RCC PF 

1 2 LCC AF 

2 1 RLMO AFL 

2 2 LMLO PFL 

 
View B 

Row Column Film View Patient Orientation 

1 1 RCC FL 

1 2 LCC PF 

2 1 RLMO PFL 

2 2 LMLO FR 

 

Images placed into cells receive the default patient orientations.  Assume View A 

is in effect.  The image placed in row 1, column 1 (RCC), will have the default 

PF orientation. 

 

Suppose the user right-clicks an image, changes its orientation to PF, then drags 

the image to row 2, column 2 (LMLO).  This image overrides the default PFL 

orientation and retains the user-assigned PF orientation. 

 

Now suppose the user selects View B for this same study.  This action applies 

View B’s default patient orientations to the images.  The image in RCC, for 

example, now has patient orientation FL. 

 

Let’s say the user closes the study.  Then you (the administrator) edit View B, 

changing the RCC patient orientation to AF.  If the study is reopened, the RCC 

image has patient orientation FL (saved with the study when it was closed), not 

AF (the new default RCC orientation AF).  However, if a new image is added to 

the RCC cell, its patient orientation will be the default AF. 
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Creating custom view codes and custom view modifier codes 
 

You can create custom view codes, which will appear in the drop-down list in the 

Film View column of the View Order list in the Local | Mammography branch 

of the Administration tree (described earlier in this section).  You can also create 

custom view modifier codes that are associated with custom view codes. 

 

Note:  When this manual was published, custom view codes 
and custom view code modifiers were not defined by DICOM or 
IHE.  Development, use and reliability of custom view codes and 
view code modifiers is the sole responsibility of the 
ClinicalExpress user. 

 

 To create a custom view code: 

1. In the Local | Mammography branch of the Administration tree, click 

the Custom button.  This opens the Customize Mammography Views 

window (see next page). 

2. In the Custom View Codes section, click the New button. 

3. Click in each column, then fill in the associated information. 

4. Click Save. 

 

 To edit a custom view code: 

1. In the Custom View Codes section, click the view code you want to edit. 

2. Click Edit. 

3. Change the information as needed. 

4. Click Save. 

 

 To delete a custom view code:  Click the view code you want to delete, then 

click Delete. 

 

Note:  A custom view code can be edited or deleted only if it is 
not referenced by a view layout. 

 

 To create a custom view modifier code: 

1. In the Custom View Modifier Code section, click the New button. 

2. Click in each column, then fill in associated information. 

3. Click Save. 

 

 To edit a custom view modifier code: 

1. In the Custom View Modifier Codes section, click the view modifier code 

you want to edit. 

2. Click Edit. 

3. Change the information as needed. 

4. Click Save. 

 

 To delete a custom view modifier code:  Click the view modifier code you 

want to delete, then click Delete. 

 

Note:  A custom view modifier code can be edited or deleted 
only if it is not referenced by a custom view code. 
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Note:  During DICOM Store and Export, custom view codes are 
added to the DICOM image header as View Code Sequence 
(0054, 0222).  All view modifier codes are sent as View Modifier 
Code Sequence (0054, 0220) which is part of View Code 
Sequence. 
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Designating mandatory data entry fields 
 

Data entry fields in the Patient Information and Study Information windows 

can be designated as mandatory (indicated by bold field names) in accordance 

with your organization’s policies. 

 

Set mandatory data fields in the Local | Mandatory Fields branch of the 

Administration tree. 

 

 
 

 

1. Set mandatory fields as required: 

 

 To require the user to fill in a field:  Check the box in the Mandatory 

column. 

 

 To make a field optional:  Uncheck the box in the Mandatory window. 

 

2. Click the Apply button. 
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Managing user accounts 
 

The User Manager enables ClinicalExpress administrators to add, change and 

delete user accounts. 

 

Note:  All ClinicalExpress users must be assigned Power User 
privileges under Windows 2000 or Windows XP. 

 

Add, change or remove user accounts in the Local | User Manager section of the 

Administration window.  Instructions begin on the next page. 

 

 
 

 



 Configuring ClinicalExpress 

P/N 18303-001 Rev. G 
Page 43 of 68 

 

 To add a user account: 

 

a. Click the Add button.  This opens the User Information window. 

 

  
 

b. For the new user, enter the User Name (i.e., the login name), Full Name 

and Description (e.g., job title).  Enter a Password for the user, then enter 

the password again in Confirm Password. 

 

c. Click Create. 

 

 

 To change a user’s full name, description or password: 

 

a. In the user list, click the user account row. 

 

b. Click the Edit button. 

 

  
 

c. Change information as needed. 

 

d. Click Save. 

 

Note:  You cannot change the user’s login name (User Name).  
To change a user name, delete that user account and create a 
new user account as described earlier in this section. 
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Note:  The Administrator’s password can be changed, but the 
Administrator’s user name cannot be changed.  Keep the 
Administrator’s password in a secure location. 

 

 

 To remove a user account: 

 

a. In the user list, click the user account row. 

 

b. Click the Remove button. 

 

Note:  The “Admin” user account cannot be deleted. 

 

 

 

Passwords cannot be recovered.  If a user forgets their password, you must delete 

the user’s account, then create a new account for the user. 
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Selecting data fields for anonymizing 
 

To preserve patient privacy, data in selected fields can be anonymized (removed 

or replaced with fixed values) when studies are sent to a target.  Original data 

stored in the ClinicalExpress database is not changed when anonymizing is 

applied to it during transmission. 

 

Setting up to anonymize data involves two steps: 

1. Designating fields to be anonymized, described in this section. 

2. Activating the Anonymize option for targets, described in “Defining targets,” 

the next section in this chapter. 

 

Add, change or remove anonymous fields in the Local | Anonymize section of 

the Administration window. 
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 To designate a field for anonymizing: 

 

a. Click the Add button.  This opens the Anonymizer Element Information 

window. 

 

  
 

b. Open the Name list and click the field to be anonymized.  You can 

anonymize these fields: 

 Patient Name 

 Patient ID 

 Birth Date 

 Patient Sex 

 Accession Number 

 Study Date 

 Study Time 

 Study Description 

 Series Description 

 

 Admitting Diagnosis Description 

 Referring Physician Name 

 Institution Name 

 Modality 

 Manufacturer 

 Study ID 

 Series Number 

 Instance Number 

 Conversion Type 

 Body Part Examined 

 

c. Optional:  Enter a Value to replace patient data.  If no value is entered, the 

field be blank when anonymized. 

 

d. Click OK. 

 

 

 To edit the anonymizing values for a field: 
 

a. Click the row for the field to be changed. 
 

b. Click the Edit button. 
 

c. In the Anonymizer Element Information window, change the Value. 
 

d. Click OK. 

 

 

 To remove anonymizing for a field: 
 

a. Click the row to be removed. 
 

b. Click the Remove button. 
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Backing up and restoring the license 
 

License backup is provided for ClinicalExpress installations.  This function 

should be set up shortly after installing ClinicalExpress.  It enables you to save 

the license key in a secure location—such as a network directory, or on a flash 

drive (USB memory stick)—to enable you to restore the license should there be a 

computer hardware or software problem. 

 

The license backup file records the number of scans remaining and the time limit 

for the license.  This file is recreated with the latest scan and time data every 24 

hours by overwriting the previous copy (for that reason, you cannot back up to a 

CD or DVD).  If ClinicalExpress isn’t running when a backup is scheduled, the 

backup will occur the next time the application is launched. 

 

Backup up the license 

 

Back up the license in the Local | License Backup section of the 

Administration window. 

 

 
 

 

 To back up the license: 

 

a. Activate the Enable License Backup option. 

b. Click the More button  , then select the location where you want to 

save the license. 

 

Note:  Do not select a location on the local computer.  Select a 
location such as a network directory, or a flash drive that is 
constantly plugged into the computer, that will not be affected if 
the local computer has a problem or must be replaced. 

 

c. Click the Backup License button. 
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Restoring the license 

 

If there is a hardware or software problem on the computer running 

ClinicalExpress, and if you activated the License Backup option (described on 

the previous page), VIDAR can restore your license. 

 

1. Start a new e-mail message. 

 

2. In the message’s To field, enter  medtech@vidar.com . 

 

3. Locate the license backup file (it will have a .ref extension) and attach it to the 

message. 

 

4. In the message body, describe the situation and request restoration of your 

license. 

 

5. Send the message. 

 

6. When you receive a reply with the restored license, install the license as 

described in step 2 of section “E. Obtain a ClinicalExpress license key” in the 

“Installing ClinicalExpress” chapter of this manual. 

 

If you cannot provide a copy of your license, you will have to purchase a new 

license. 
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Defining targets 
 

Administrators can set up, edit and delete parameters for targets and remote 

devices.  A target is a destination for studies and/or a source for Modality Work 

List data (Modality Work List can be purchased separately). 

 

Work with targets in the Targets branch of the Administration tree. 
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Creating a new target 
 

1. Click the New button.  This displays the New Target page. 

 

  
 

2. In the Target section: 

 

  
 

a. Enter the target’s Name.  This should be a clear, short name, such as  

“Clinic” or “Dr. Gale”.  Choose names that users will not confuse. 
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Note:  After the name is entered and the target is saved, the 
name cannot be changed.  To change the name, you must 
delete the target and create a new one. 

 

b. Select the target Type.  Choices are: 

 DICOM STORE 

 STORAGE COMMITMENT 

 MODALITY PERFORMED PROCEDURE STEP 

 DICOM PRINTER 

 POSTSCRIPT PRINTER 

 DICOM CD 

 MODALITY WORK LIST 

 DICOM PATIENT QUERY 

 

Note:  The Type field controls which fields can be changed in 
the left set of sections of the New Target window, and controls 
fields displayed in the right section (Configuration). 

 

c. (Optional) Enter a Description for the target. 

 

d. To designate this target as the default:  Activate the Default option.  

Information from the default target appears in the Target section of the 

ClinicalExpress main window when the program is started and when the 

user clicks the Default Target button. 

 

Tip:  If this workstation will be sending studies to only one 
target, or if one target will be the destination most of the time, 
set that target as the default. 

 

e. To anonymize data sent to this target:  Activate the Anonymize option.  

Fields selected for anonymizing in the Local | Anonymize window (see 

“Selecting data fields for anonymizing,” the previous section in this 

chapter). 

 

f. To allow baseline JPEG lossless compression for this target:  Activate 

Allow Lossless Compression. 
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3. In the Communication section: 

 

  
 

a. Enter the remote destination’s AE Title (Application Entity Title).  AE 

Titles are case sensitive. 

 

b. Enter the target’s PDU Size (Protocol Data Unit size) in bytes.  This 

specifies the maximum block size the target can receive from 

ClinicalExpress. 

 

Note:  AE Title and PDU Size are normally defined by the 
receiving program. 

 

c. Enter the required Response Timeout in minutes.  This is the amount of 

time ClinicalExpress will wait for a response after sending a 

communication to the target.  Heavy network traffic will slow 

ClinicalExpress operation.  Maximum value is 5 minutes.  To specify an 

infinite timeout, enter 0. 
 

d. Enter the receiving application’s Port number (e.g., 104, 4006). 
 

e. Enter the receiving application’s Host Name or IP address. 
 

f. If the target will be accessed over a dial-up connection, activate Dial-up, 

and enter the required information. 
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4. The Digitizer section enables you to set the default bit depth and resolution, 

and to control whether users can override the defaults.  The default Bit Depth 

is 16 and Resolution is 570.  In the Digitizer section: 

 

  
 

a. To enable the film size to set resolution:  Activate the Set Film Size Based 

Resolution option. 

 

b. To change the default bit depth and resolution:  Activate the Enable Bit 

Depth and Resolution option, then set Bit Depth and Resolution to the 

required values.  (Available values depend on the attached digitizer.) 

 

c. To enable users to override the default bit depth and resolution:  Activate 

(or leave activated) the Enable Bit Depth and Resolution option.  

Considerations: 

 Deactivate the Enable Bit Depth and Resolution option if the target 

should receive images captured at a specific bit depth and a specific 

resolution.  This is the recommended configuration if you are not using 

the Set Film Size Based Resolution option. 

 Activate the Enable Bit Depth and Resolution option if the target can 

receive images captured at any available bit depth and resolution, and if 

ClinicalExpress user(s) are trained to select settings appropriate for the 

study and target. 

 

Note:  Each facility is responsible for assuring that bit depth and 
resolution are clinically appropriate for the images and studies 
for which ClinicalExpress is used. 
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5. Options in the Configuration section depend on the selected target Type.  

Follow instructions for selected target Type: 

 

 

 For target Type DICOM STORE: 

 

  
 

a. If a Look-Up Table is available for the target, activate LUT, then click 

the ... button (see arrow) to select the LUT file. 

 

b. If ClinicalExpress is to respond to storage commitment messages from a 

target: 

 Activate Storage Commitment. 

 Select a Target, or select Same for this option to apply to the current 

target. 

 Enter a Maximum Wait Time.  ClinicalExpress will not take action 

unless it receives a storage commitment confirmation within this 

time. 

 

 

 For target Type STORAGE COMMITMENT: 

 

  
 

 Enter a Maximum Wait Time.  ClinicalExpress will not take action unless 

it receives a storage commitment confirmation within this time. 

 

 

 For target Type MODALITY PERFORMED PROCEDURE STEP, there 

are no configuration options. 
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 For target Type DICOM PRINTER: 

 

  
 

a. If a Look-Up Table is available for the printer, activate LUT, then click 

the ... button (see arrow) to select the LUT file.  Available LUTs are in 

the printer-specific directory on the ClinicalExpress installation CD. 

 

b. If a Look-Up Table is not available for the printer, activate Apply SDF 

(Standard Display Function), then: 

 Set Printer Type to match the DICOM printer. 

 Set Transformation Type to SCP (printer applies SDF to image) or 

SCU (ClinicalExpress applies SDF to image).  For the 

Transformation Type to be valid, the DICOM Printer should 

support the Presentation LUT SOP Class (check printer’s manual for 

details); this will be negotiated by the software during the association 

phase. 

 If Apply SDF on image even if not supported by printer is 

activated, and the printer does not support Presentation SOP Class 

(check printer’s manual), ClinicalExpress generates the SDF values 

(based on Illumination and Ambient Light fields) and applies a 

LUT to the image before sending it to the printer. 
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 Enter Illumination (luminance due to illumination) and Ambient 

Light (luminance due to ambient light) values to be used in the SDF 

calculation.  DICOM default values are: 

 Transmissive media 
(film) 

Reflective media 
(paper) 

Illumination 2000 cd/m
2
 150 cd/m

2
 

Ambient Light 10 cd/m
2
 0 cd/m

2
 

 

c. In the Settings section: 

 Set Magnification as required.  Options are: 

 Replicate (each printer pixel represents one image pixel). 

 None (fits image to printer medium size without resampling). 

 Bilinear (fits image to printer medium size using bilinear 

resampling). 

 Cubic (fits image to printer medium size using cubic resampling). 

 Set Film Orientation to Portrait (long edge is vertical) or 

Landscape (long edge is horizontal). 

 Select the target’s media: Blue Film, Clear Film or Paper. 

 Set the target’s Film Size in inches. 

 Set DMin (minimum film opacity) and DMax (maximum film 

opacity). 

 Activate True Size to print at the exact aspect ratio of the original 

film.  If not activated, the image’s aspect ratio will be altered to fit 

the printable area. 

 Printable Area specifies the printable area that will be used to crop 

the image if the requested output size is larger than the printer’s 

printable area. 

 

More about Printable Area 

A duplicate film typically has a smaller printed area than the original film of the same overall size.  

 When printing an image on media the same size as the original film, expect some shrinking or 
cropping to occur (depending on settings in the Configuration section of the DICOM PRINTER 
target, and available options provide by the server and printer.) 

 When printing an image smaller than the printer’s printable area (which is usually 14" x 17"), the 
resulting image will be the same size as the original. 

Example:  Suppose the printable area is 13.5" x 16.5" and the resolution is 150 pixels per inch.  The 
Printable Area would be 

14X17:2025,2475 

where 14X17: is the original film size (must include uppercase “X”) 

 2025 is the printable width in pixels (13.5 inches x 150 pixels per inch) 

 2475 is the printable length in pixels (16.5 inches x 150 pixels per inch) 
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 For target Type POSTSCRIPT PRINTER: 

 

  
 

a. If a Look-Up Table is available for the target, activate LUT, then click 

the ... button (see arrow) to select the LUT file.  Available LUTs are in 

the printer-specific directory on the ClinicalExpress installation CD. 

 

b. Click Settings to open the standard Print Setup window.  In this 

window, you can select a printer and change its properties. 

 

Note:  Postscript printer drivers must be installed to support this 
target type.  See printer manual for driver information. 

 

 

 For target Type DICOM CD: 

 

  
 

a. Set the number of Copies to be created. 

 

b. Select the CD Drive. 

 

 

 For target Type MODALITY WORK LIST: 

 

  
 

a. Activate Use Only Patient Information to import only basic patient 

information from a Modality Work List query. 
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b. Activate Enable Broad Query if the system can access multiple 

Modality Work Lists and you want the user to be able to search all 

MWLs with a single query. 

 

c. Activate Scheduled Procedure Step Start Date to Study Date to map 

procedure date to study date when creating a new patient account by 

querying the MWL server. 

 

d. Activate Requested Procedure ID to Study ID to map a requested 

procedure ID to a study ID. 

 

 

 For target Type DICOM PATIENT QUERY, there are no configuration 

options. 

 

 

6. When all target information has been entered, click the Save button.  The new 

target will appear in the Targets section of the Administration window. 
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Managing target information 
 

 

 To list existing targets:  Click Targets in the Administration tree. 

 

 
 

 

 To view a target’s settings:  Click the target’s name below Targets in the 

Administration tree. 

 

 

 To edit a target’s information: 

 

a. Click the target’s name below Targets in the Administration tree. 

  or 

 Click the target’s name in the target summary list. 

 

b. Click the Edit button.  Fields become active and can be edited. 

 

c. When done, click the Save button. 

 

 

 To delete a target: 

 

a. Click the target’s name below Targets in the Administration tree. 

  or 

 Click the target’s name in the target summary list. 

 

b. Click the Delete button. 
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Verifying communication 
 

After defining a target, it’s recommended that you test communication between 

ClinicalExpress and the target or MWL broker (the ClinicalExpress MWL feature 

can be purchased separately).  You can, of course, test at any other time. 

 

1. In the main ClinicalExpress window, File > Generate Test Pattern > 

SMPTE.  This uses a special acquired study that exists strictly for testing 

purposes. 

 

2. Open the Target list and click the target to be tested. 

 

3. In the Target section, click the Verify button (just below the target drop-down 

list). 

 

4. Wait for ClinicalExpress to respond.  It will display one of two messages: 

 

 “Target – [target name].  Verification request succeeded.” indicates the 

target successfully responded to the DICOM Echo command from 

ClinicalExpress. 

 

 “Target – [target name].  Verification request failed.” means that the target 

has not responded to the Echo command.  If you see this message, check 

the target configuration details in ClinicalExpress, then make sure the 

network is operating correctly. 

 

 

 

Reviewing the film digitizer’s configuration 
 

View digitizer configuration in the Digitizer branch of the Administration tree. 
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Checking Modality Work List availability 
 

Note:  The ClinicalExpress Modality Work List option can be 
purchased separately.  Your copy of ClinicalExpress must be 
licensed for Modality Work List before this feature will be 
available. 

 

Note:  The instructions in this section assume that the 
administrator completed the instructions for creating a new 
Modality Work List target (see “Defining targets” section, earlier 
in this chapter). 

 

 

 To determine whether the Modality Work List option is installed: 

 

a. In the main window, View > Acquired Studies. 

 

b. In the Studies Information window, check the Targets list: 

 If at least one target is in the list, the Modality Work List option is 

installed and has been already set up for one Modality Work List target. 

 If the list is empty, the Modality Work List option is not installed. 

 

c. In the Studies Information window, click Close. 

 

 

 To verify that the ClinicalExpress workstation is connected to a Modality 

Work List source: 

 

a. In the main window, open the Target list, then click a Modality Work List 

target. 

 

  
 

b. Click Verify. 

 

c. A message window will tell you whether the connection is operating. 

 

 

Note:  For complete instructions on using Modality Work List, 
see “Import existing patient data using Modality Work List” in the 
“ClinicalExpress operation guide.” 
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Reviewing and managing the log file 
 

The log file—a text file stored in the program directory—contains a record of the 

actions carried out by ClinicalExpress.  Use the log file to review and analyze 

user and program activities for troubleshooting purposes.  ClinicalExpress 

provides a window for viewing and managing the log file. 

 

 

 
 

 

 To view the log file:  View > Log File. 

 

 To remove data from the log file:  Click the Clear Log button. 

 

 To read new data into the log file:  Click the Refresh button. 

 

 

Note:  Set log options in the Local administration page (see 
“Log” in the “Setting local workstation parameters” section, 
earlier in this chapter). 
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Calibrating the film digitizer 
 

Calibrate the film digitizer as recommended by the film digitizer’s operation 

manual. 

 

Note:  Calibration will take several minutes, during which you 
will not be able to use the digitizer or ClinicalExpress. 

 

 To calibrate the digitizer: 

 

a. Options > Calibrate Scanner. 

 

b. Confirm that you want to initiate a calibration. 

 

  
 

c. Wait while the film digitizer calibrates. 

 

  
 

d. When the calibration is complete, click Yes. 
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Calibrating your display 
 

Good image quality depends on proper display output.  When your display 

accurately presents an image, you can effectively evaluate image quality and 

successfully optimize the image.  Even if the film was properly digitized, the 

image may appear to have poor quality on an uncalibrated display.  Two easy 

methods for calibrating a display are provided in this section. 

 

Report display problems to the medical physicist in charge of display QC.  

Display problems should be investigated by more in-depth evaluations and 

followed up by readjustment, service, repair, or replacement of the device. 

 

For more rigorous display calibration, VIDAR recommends VeriLUM products, 

available from: 

 

 IMAGE Smiths, Inc. 

 P.O. Box 30928 

 Bethesda, MD  20824 

 

 Voice: (240) 395-1600 

 Web www.image-smiths.com 
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Calibrating with the SMPTE test pattern 
 

1. File > Generate Test Pattern > SMPTE to open the SMPTE pattern image 

(shown below). 

 

2. Minimize the display’s contrast and brightness controls. 

 

3. Increase the brightness until you just see the bars in the corners. 

 

4. Increase the contrast to about 80% or greater until you can see the 0%/5% and 

95%/100% squares on the image as clearly as possible. 

 

 

 
 

0%/5% square 95%/100% square 

 

 

 

Note:  If you are viewing an electronic copy of this document on 
a display and you can’t see either the 0%/5% square or the 
95%/100% square on this page (indicated by the arrows), then 
your display needs to be calibrated. 
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Calibrating with the TG18-QG test pattern 
 

1. File > Generate Test Pattern > TG18-QC to open the TG18-QC pattern 

image (shown below). 

 

 
 

 

2. Visually inspect the following characteristics: 

 

a. Geometrical distortion:  Verify that the borders and lines of the pattern are 

visible and straight, and that the pattern is centered within the active area of 

the display device. 

 

b. General image quality and artifacts:  Evaluate the overall appearance of the 

pattern.  Note any non-uniformities or artifacts, especially at black-to-white 

and white-to-black transitions.  Verify that the ramp areas appear 

continuous without any contouring artifacts. 
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c. Luminance, reflection, and noise:  Verify that all 16 luminance patches are 

distinctly visible. Verify that the 5% and 95% patches are visible.  Evaluate 

the appearance of low-contrast letters and confirm the visibility of targets 

at the corners of all luminance patches. 

 

d. Resolution:  Evaluate the appearance of Cx targets at the center and the 

corners of the pattern and score them compared with the reference.  The 

scores should be <5 for primary displays and <7 for secondary ones.  Also, 

verify the visibility of the line-pair patterns at Nyquist frequency at the 

center and corners of the pattern.
*
 

 

 

 

 

 

 

 

 

 

Contact VIDAR Technical Support if you have any questions 
about configuring ClinicalExpress software: 

Phone: +1.800.471.SCAN (+1.800.471.7226) 

 +1.703.471.7070 outside the U.S. 

E-mail: medtech@vidar.com 

 

 

                                                      
*
 Steps 2a through 2d reprinted by permission from “New Developments in Display 

Quality Control,” by Ehsan Samei, in Quality Assurance and Quality Control in the 

Digital Imaging Department, Eds. E. Siegel, B. Reiner, J. Carrino, SCAR Premier Series, 

Society for Computer Applications in Radiology, Great Falls, VA, 2002, pp. 71-82. 
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